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Introduction

Scope and Target Audience

This document is intended to provide novice users having only the most primitive understanding of
Windows and their digital cameras with some indispensable Adobe Photoshop editing skills.

This document is not intended to provide an overall understanding of Adobe Photoshop or of
Windows, but to help users who are preparing pictures for printing or emailing get more satisfactory
results than are possible with the crappy image editing software that typically ships with digital
cameras.

This document is based on Version 7.0 of Photoshop running in Windows 2000 or XP, but most of the
information is also applicable to other versions of Photoshop.

Organization

Except where noted, the how-to chapters are arranged in the sequential order in which you should
undertake the steps in order to preserve the quality (minimize the degradation) of your pictures along
the way.

Managing your files

Windows file management is outside the scope of this document. However, you need to set up a file
system that will make sense to you and allow you to save multiple (original and edited) versions of the
same picture without confusing yourself. Depending on how you work, it is probably useful to set up
subfolders in the Windows "My Pictures" folder, and to use intuitive (informative) names when naming
folders and files.

Back them up!

| strongly suggest that you back up your picture files (all your files, in fact) somehow (rewritable CDs,
DVDs, portable hard drive, additional networked computer) so that you don’t lose them in the event of
a hardware failure. If you store the backup in a separate location (home/office, safety deposit box),
you will also protect your pictures in the event of fire or theft.

Opening a Picture

There is more than one way to get a picture open in Photoshop.

Opening a File Using Windows Explorer

Right-click on the picture and choose "Open With..." then select Adobe Photoshop. (Note to some
users: the very first time you do this after installing Photoshop, it might not be listed, so you might
have to click on the "Choose Program..." button and find the Photoshop application in a subfolder of
the C:\Program Files\Adobe\ folder on the C: drive.)
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Opening a File Using Adobe Photoshop

First start the Adobe Photoshop program, then choose the "File - Open" command from the menu
(the list of words across the top of the window), and find and open your picture.

Adjusting Colors and Brightness

These actions are particularly useful if you have taken pictures under low-light conditions without
using the flash, and can also be used to improve the contrast on pictures taken under various
conditions.

Auto Levels
A useful first step is to try Auto Levels. ("Image - Adjustments - Auto Levels")

Adjust Levels

If Auto Levels didn't yield satisfactory results, you might undo it (see the appendix) and try adjusting
the levels yourself. "Image > Adjustments - Levels" brings up a dialog box that shows a histogram
representing the brightness levels ("Input Levels") in your picture. Immediately underneath this
histogram (and above "Output Levels”, which you should ignore) are three little arrows representing
black, 50% gray, and white. Slide these around and examine the effect on the image brightness and
contrast. (Make sure "Preview" is checked.) Press "OK" once you've set levels you're happy with.

Rotation

Clicking "Image - Rotate Canvas" will get you here.

If you held your camera sideways to take a picture, you can rotate the picture 90 or 180 degrees here.
(This step may not be necessary because newer cameras generally seem to be pretty good at
automatically sensing and compensating for being held sideways.)

There is also the "arbitrary" setting, where you can rotate the picture any amount, clockwise or
counterclockwise. This is particularly useful for leveling a horizon or other obvious vertical or
horizontal line. After rotating your picture an arbitrary amount, you will need to crop it (see below) to
fix the corners.

Sharpening
This is useful to bring out the detail in some pictures. It is also useful to try sharpening the picture
before reducing its size as this sometimes results in a more discernible reduced image.

Choose Sharpen ("Filter - Sharpen -> Sharpen”), Sharpen More ("Filter - Sharpen - Sharpen
More"), or Sharpen Edges ("Filter - Sharpen -> Sharpen Edges"). The filter you should choose
depends on the texture of your subject material. Experiment, Undo, and make your choice.

Cropping and Resizing

About Aspect Ratios and Printing
The "aspect ratio” is, simply, the ratio of the width to the height of an image.

A warning: the standard picture sizes available in photo printing labs (5x7, 8x10, etc.) have a certain
aspect ratio. When you crop a picture, you might be left with an aspect ratio that is different from the
standard aspect ratios. There's nothing wrong with this, but you must be careful when ordering prints
to make sure that the edges of your pictures aren’t cut off!
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Cropping
Before you can crop an image, you need to specify the part of the image that you want to

keep, so you need to be using the Rectangular Marquee tool. If you can't see the tools
(the vertical bar full of icons on the left-hand side), pressing the "tab" key once or twice will

8

probably make it visible. Failing that, clicking "Window - Tools" will reveal it. L1 DL‘*'
The Rectangular Marquee tool is the dotted rectangle in the upper left-hand corner of the E’ﬁ, _
tools. Click it once to select this tool. 7 &
You will also need to see your entire image. Zoom out (see the appendix) if necessary to J) Vv
accomplish this. P
Drag and Drop (click the left mouse button near the top left-hand corner of the picture, %‘ Z
hold it while moving the mouse, and then release it near the bottom right-hand corner) | £7, L4,
over an area of the picture to select the portion of the picture to keep. Then click "Image | ( &>
- Crop" to crop the picture.

k. T.
Resizing $. @,
This section is located here, towards the end of this document, for a reason! To avoid |_E§‘ fd
duplicating your effort, you should do most of your processing before you reduce the size Mm@

of your pictures. If you will be both printing and emailing your pictures, you should save
the picture once before resizing it (for printing at the maximum possible resolution), and
then again after reducing its size.

Click "Image - Image Size" to bring up the dialog box. Let's concern ourselves only with
the top half of this box ("Pixel Dimensions"). Here, it shows you the current size of your |/l
picture in pixels. You can enter new values, as pixel values (pictures 700 or 800 pixels IEI_EI o
wide and about 500 pixels high work well for emailing), or expressed as a percentage of =
the original value. T

You should leave your image at full size, i.e. not resize it, if you want to print it.

One more thing: don’t bother enlarging your images here, even if you will be ordering very large prints.
You cannot add resolution this way. They will just become grainy and unclear.

L
=

Saving your File

About File Compression

The term "file compression” refers to strategies to reduce the size of files by removing redundant
information. Compressed files take up less space on your hard drive and are easier to move around
the web. There are various industry standards for file compression. ("MP3", for example, is a well-
known compression standard for audio files.) "Jpeg", or "jpg", is a file compression standard for
image files.

Jpeg is an industry web standard, not an Adobe contrivance. Canon cameras, such as my wonderful
little elph, save images as uncompressed jpegs.

The degree of compression is variable, and represents a tradeoff between image quality and file size.
You want to save your jpegs rather highly compressed if you are going to email them, or save them at
the minimum compression setting if you are going to print them. (Exactly how to do this is explained
below.) There are file formats that are more suitable than jpegs for saving work for print, such as
Windows bitmaps and TIFF file formats, but these are outside the scope of this document.
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Save for Web

Clicking "File > Save for Web" will bring up the large and intimidating "Save for Web" dialog box. To
the right of your picture, you will see a "settings" area. In the top left-hand corner of this area, you will
see a drop-down list box with file formats listed therein. Set this to "JPEG" if it is set to anything else.

After this is correctly set, you will see a "Quality" setting just to the right (and down a bit). This is
where you choose the degree of compression. If you click once on the little arrow, a slider will appear.
Suggested settings are 65% quality (slightly compressed) for email distribution of photos, and 100%
guality (minimal compression) if you are taking your pictures in to be printed.

Save on File Close

When you close the original file, if you used "Save for Web" (rather than "Save As...", which is
another save option), Photoshop will ask you whether you want to save your changes. If you have
been following this tutorial, you might want to keep the original, unmodified, file under its original
name, in case you would like to work with it again. In this case, make sure you choose "No"!

Appendix

Zooming and the Navigator

B G]] clicking "Window - Navigator" or pressing the "tab" key once or
Mavigator “{ Info ™, + | twice will reveal the navigator, probably near the top-left hand
T corner of your screen. This lets you zoom in on portions of your

picture, and zoom out on pictures that are very large (if you are
preparing pictures for print, they will be much too big to see on the
screen and you will have to zoom out somewhat). Very large

pictures automatically open at a reduced magnification so that the
10 Wik S N B =] ] entire image is visible.

Oops! Undoing Your Edits

There are two ways to undo things that you have done and regret having done.

Undo and Redo

Toggle (switch back and forth between) your most recent edit by holding the "Ctrl" key and pressing
"Z" ("Ctrl + Z"). Press this combination of keys again to redo this edit. This method has two
limitations: first, you can undo (and redo) the most recent step only, and second, it is unavailable
after you have saved your work.

Repeatedly pressing "Ctrl + Z" is useful when you can't decide whether you're happy with the last
change you made, such as sharpening an image or adjusting the color balance, because it lets you
quickly compare the changed and unchanged versions of your picture.
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H | StO I'y History ctions Tonl Presets L
Make sure you can see the "History palette” ("Window" - |« MNew
"History" to toggle it on or off). Here you can see a chronological
list of your past actions. Click anywhere on this list to step = U
backwards to that point, then click on the bottom item of this list to =1 Faste
return to your current position (redo all of your recent edits). This [™1 Rectanqular Marquee
is useful to evaluate the combined effect of several of your recent T
dltS :._JI guiar Wargquee
ears. . : . . . B crop
Be warned that if you click to a previous position on this list and S Dacelect
then make a new edit, you will lose all of your subsequent edits :1
(new changes) below your current position on the history list! L4 Fectangular Marquee
El [eselact
For More Help [:] Fectangular Marquee
For more information, press the F1 key or click "Help" - B cror
"Photoshop Help" to access the Help Menu. Here, you can find a =j Deselect
bewildering amount of information. {71 Rectangular Marquee
Crap
. . . E @ ;
Monitor Calibration ]

It's outside the scope of this document, but, to make sure the color balance of your printed pictures
matches what you see on the screen, you will need to calibrate your monitor. Once Photoshop has
been installed, check the Windows control panel for the "Adobe Gamma" utility. If you run this utility
in the "step-by-step" manner, it is self-explanatory.

Copyright Notice

The terms "Adobe" and "Photoshop" are trademarks of Adobe Corporation. The term "Windows" is a
trademark of Microsoft Corporation.
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